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EndNote

EndNote is a reference management software package which can be used to manage
bibliographies and references when writing thesis and other academic texts. References can be
imported directly from library catalogues and article databases into the software. EndNote is
connected to Microsoft Word, enabling you to insert citations as well as automatically create and
update a literature list in your Word document. The software has many different bibliographic
styles that define the appearance of your citations and literature list. With EndNote, it is possible
to quickly change the bibliographic style of a text.

This guide contains what you need to get started with EndNote. For more information, go to the
university library’s home page: http://www.uis.no/library/write-and-refer/endnote/quidance/

Locating and starting EndNote

To install the software on a PC connected to the UiS network:
e (o to the start menu and search for EndNote
e Click through the demo, or close it by clicking the X in the right-hand corner
e Go to File > New to create a new library
e Save the library

You can also download EndNote for you own PC here:

http://www.uis.no/library/write-and-refer/endnote/quidance/

Save EndNote as you would save any other software. We do not recommend saving EndNote in
cloud storage services like Dropbox or OneDrive.

Two folders will be created for your EndNote library: .enl and .data. .enl is the library folder,
while .data contains attached files, like PDFs. The folders can be copied, moved and deleted.

NB! It is strongly recommended to backup your library often! You do this by choosing File >
Save a Copy, and saving the copy with the name you want.

You can choose where to save the backup. You may want to save it to the same place that you
save backups of documents you work on. This way you can establish a routine where
you take backup of the library at the same time as you backup other documents.

We recommend having just one library. Problems may occur if you cite from different libraries in
one Word-document. Use Groups in EndNote (see page 19) to sort your library.


http://www.uis.no/library/write-and-refer/endnote/guidance/
http://www.uis.no/library/write-and-refer/endnote/guidance/

If you have more than one library:

Decide which library to open from Word and when exporting from databases:

Have your preferred EndNote library open.

Go to File - Preferences - Libraries

- "When EndNote starts": Select “Open the specified libraries”
- Click on “Add open libraries”.

- Tick off "Show library name in reference window ".

- Press OK.

Your library

EndNote should always be opened from the start button, and not via Word.

Mode Fields Help .
Rating Layout/Preview

|
1 M«e X8 - DD EndNote Library] V" \ ’ {#M

@ File Edit References Groups Tools Window Help _ =)=
@@ ‘ APABth 2 = @L & @ | 77‘ E 2 EE | O Ry 2 - Quick Search Q + A Hide Search Panel
My Library W’ Gy = ElMetchCase. Mt Wrds  preview | Bastacnea ol | @ =
» ||[Aries, P (1976). Western attitudes totvard death: from the
(© Syne Status Auther T eins Ll ‘ Pl iddle Ages to the present. London: Marion
= \ Boyars.
4D Recently Added © |® @ Author Year Tlt\e‘ Rating Journal Last Updated  Ref * ”
Blj unfiled ) (@ 1990  The Green booklet: some measures used in dif... 08.05.2015  Bor
T Trash ©) | ®  Agledahl KM;G.. 2011  Courteous but not curious: how doctors’ polite... Journal of med... 09.02.2016  Jou =
® & Abum,Dag;We.. 2008 Do diseases have a prestige hierarchy? A surve... Social Science .. 01032016  Jou
| =My Groups ® @ Alikhanov,A.A. 2013  Stability and convergence of difference sche. Differential Eq.. 01.03.2016  Jou
Bl Forstehjelp (2) |® @ AwarezSanlaim.. 2013  Verticalintegration and exclusivities in mariti... Transportation .. 01.03.2016  Jou
| Bi0penAccess o Alvesson, Mats; S.. 2012 Un-and re-thinking leadership: Context, relations... Advancing relat... 17.06.2015 Boc
B skjonniitteratur @ |®  AndersenB. 2010 The intensive care unit: a room of meaning for... Nordic Journal . 09.02.2016  Jou
)

Conversation, language, and possibilities: a pos... 09.022016  Box

2 Teologi

Samtale, sprog og terapi: Et postmoderne pers... 09.02.2016  Box

|| & Find Full Te g A portable, shock-proof, surface-heated dropl Biosensors & B... 01.03.2016  Jou
[ pe 1976  Western attitudes toward death: from the Mid—. + = = » - 3

®  Asunda, Paul A; Integrated STEM: A NEW PRIMER FOR TEACH 12.01.2016 i

®  Aveyard Helen 2010  Doingaliterature review in health and social c... 09.02.2016  Box

! ®  Axelsson, Christ.. 1992  Axillary dissection of level L and Il lymph nodes... Europeanjourn... 12.012016  Jou

| ®  Bailey, Carz;Mur. 2011  Professional tears: developing emotional intelli... Journal of Clini..  09.02.2016  Jou

®  Bang Susane 2003  Rert,rammetog rystet: faglig vekst giennom .. 09.02.2016  Box

®  Bateson.Gregory 1972  Steps to an ecology of mind 09.022016  Box

Beauchomp, Mar.. 2002 Rele ambiguity, role efficacy, and role performan. Group Dynamic... 07.052015  Jou

®  BeckerEmest 1973  Thedenial of death 09.022016  Box

®  JessicaBenjamin 2004  BEYOND DOER AND DONE TO: AN INTERSUBJ... The Psychoanal... 09.02.2016  Jou

®  Benktson, Benkt.. 1976  Varat och tiden : introduktion till Martin Heide... 09.02.2016  Box

| Benner, Patricia 1984 From novice to expert: excellence and power in cl.. 26.04.2016 Boc

| ®  BennerPatrida 1994 i : i . 09.02.2016  Box

®  BennerPatridca 2011  Formation in Professional Education: An Exami. Journal of Med... 00.02.2016  Jou

YO u can ®  Benner,P;Sutp.. 2007  Learning across the professions: The clergy, a c... Journal of Nurs.. 09.02.2016  Jou

®  Bion WilfredR. 1962  Learning from experience 09.02.2016  Box

®  Bion WilfredR;.. 1994  Clinical seminars : and other works 09.022016  Box
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Modes

It is possible to work in three different modes in EndNote. A new library will open in local mode.
We recommend using local mode (far left).

B

If you were to use Online search mode (far right), you could search and retrieve references from
EndNote and save them in a temporary library. Instead of doing this, we would recommend that
you go to ORIA or to online databases to import your references. This is explained under
“Exporting references from databases and library catalogues”.

Style

To select in which bibliographic style you wish EndNote to display your references, choose from
the dropdown menu in the top left corner.

Display fields

You can choose how many information fields EndNote displays in the library window and
determine the order in which they are shown. Go to EndNote X9 — Preferences — Display fields.

Rating
Here you can rate your references by giving them 1 to 5 stars.
Preview

On the right-hand side of the screen there is a preview column. Click Reference to show all the
information on the selected reference. Click Preview to view the reference as it will appear in the
literature list. Click Attached to view any attached PDFs. Click the paperclip to attach documents
to the selected reference.



Layout

Your EndNote library window contains several panels, which display information. By clicking the
Layout button, you can change their orientation and placement as you see fit.

[T] Q~ Search Library

Show Search

:Updated
Hide Groups 0.14
Bottom - PDF B2

814

Bottom - Split
¥ Bottom - Preview 8.14

Right - PDF 1.04
Right - Split 1.01
Right - Preview 342
References Only
___E.13

L.

You can decide if you want the help screens on the left, right or bottom of the library window.

PDF (...) will display any attached PDFs in full text.
Split will display the reference in full and an overview of any PDF.
Preview will display the reference as it will appear in your literature list.

o OB D4 QAXO

Clicking the paperclip icon attaches documents to your reference.
Clicking the icon displaying a window with arrow opens the PDF.

References

Endnote sorts your references alphabetically. You can view and edit each reference by double-
clicking on them or hitting Enter when they are highlighted.



An example of a reference:

[ NON ] Haselhubn, 2015 #4
< % Journal Article I - XY @ % El & & I__=’|
Rating

= o o= 8 %

Haselhubn, Amberlee S.

Wijnen, Bas
Anzalone, Gerald C.
Sanders, Paul G.
Pearce, Joshua M.
Year

2015

Title

In situ formation of substrate release mechanisms for gas metal arc weld metal 3-D printing

Journal
Journal of Materials Processing Technology

Volume
226

Issue

Pages
50-59

Change case

If the title of a reference is imported in capital letters, this can be fixed by highlighting the title
and going to Edit > Change Case in EndNote.

Some words and abbreviations should always be written in capital letters. To create a list of
words which EndNote will be forbidden to change the case of, go to EndNote X9 - Preferences
- Change Case.

EH -'_:" E‘,‘ O\.‘ QQ‘ E @E‘ Plain Font ~ Painsize - | B [T ulEH AL AL
Sentence case,

Reference Type: Book = ’_
lowercase

UPPERCASE

.....

Author Capitalize Each Word
Ariés, Philippe tOGGLE cASE

Year
1976
Title
ESTERN ATTITUDES TOWARD DEATH: FROM THE MIDDLE AGES TO THE PRESE

Series Editor

Series Title



Adding references manually

e Open your EndNote library.

e Go to References > New Reference, or click this button:
e Choose the correct reference type:

- ——
EndNote X8 - rence]

@ File Edit References Groups Tools Window Help

Reference

T attached POFs | @
E '7'|E‘,‘.\)‘®|§@|Plamhnt -~ Plainsize -

Encyclopedia -
Equation
~~~~~ Figure
Film or Broadcast
Generic
Government Document
Grant
Hearing
Interview
i
Title Legal Rule or Regulation
Magazine Article
Manuscript
Map
Music
MNewspaper Article
Online Database
Online Multimedia
Issue Pamphlet
Patent

B J UP|A A = A~

Journal

Volume

Personal Communication E
Pages Podcast
i Press Release
Report
Start Page Serial
Standard
Statute
Epub Date Thesis
Unpublished Work
Web Page <

Date

Type of Article

Short Title

e Book for a book or a report written by one or several authors.

¢ Book section for a chapter in a book or articles from a conference.

o Edited book for edited books (anthologies).

¢ Electronic Book / Article for documents found online or in a full text database.
e Journal Article for printed journal articles.

e Web Page for other materials found online.

There are many different types of references in EndNote. You can change the reference type
after saving a reference.

Press the Tab key and Shift + Tab to go up and down between the fields in the reference. Press
the Enter key to make a new line. Do not use full stops and do not leave empty lines.

Author: Must be written in inverted form: Olsen, Per
If a reference has several authors, write each name on a separate line by pressing the Enter
key.



Always write names in full. EndNote will automatically change the first name to initials,
according to the demands of the chosen reference style.
New names appear in red:

Author

Aven, Terje
Milsen, Espen Fyhn
Milsen. Thomas

Be sure that you always write an author’s name correctly.

Organization as author: for example Universitetet i Stavanger.

Use Author field. EndNote interprets everything that is entered in this field as person names,
and records it in inverted form (Last, First) if this is not already done. To prevent this from
happening with organization names, type a comma after the name, as follows: "University of
Stavanger,."

Title: write the title without punctuation, but use colon to separate between main and subtitle.
For example Marketing research: an applied orientation

Journal: write the title of the journal in full. Pay attention to the letter case.

Pages: write the page number in full (1442-1449) or shortened (1442-9). Do not write p. or s.
EndNote will do this according to the chosen reference style.

Label: use this field to refer to your own archival system, folders and so forth.
Keywords: keywords, subject words. These will be searchable.

Abstract: a summary of the article written by yourself or imported along with the rest of the
reference.

Notes: use this field, as well as Research notes, to add personal notes to the reference.
DOI: Digital Object Identifier (see p. 12)

URL: Internet address of the document.

File attachments: attached files like PDFs and Word files, which are part of your library. The
files are stored in your library. Anything stored as a PDF is searchable.




You can use your library’s search panel to search for PDF files.

Some fields are mandatory for a complete reference

Mandatory fields for book references:

Author, title, year of publication, publisher, place of publication.

If the book has several publishers, choose the first one. The also applies to place of publication.
If a book has several editions, you need to write which one you are using, for example 29, 4t
and so forth.

Mandatory fields for article references:
Title and author of the article, journal name, volume, issue and page numbers.

Mandatory fields for web documents:
Title and author, year of publication, web address (URL), retrieval date and the latest update
date.

Kildekompasset.no

When you are about to insert references we strongly recommend that
you use www.kildekompasset.no. Here you will find a list of examples
that shows which fields you need for different kinds of references, and
how the references should look like.
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Making references of electronic sources

Electronic sources can be articles, blogs, e-mail groups, databases, newspapers, web pages
and so forth.

Minimum requirements for referencing a web document are title or description, date (publication
or latest update), access date and URL. Include the author’'s name if you can find it.

Always make a copy (paper or electronic) of any web pages you use, and save it. Web pages
may change or disappear. This does not apply to scientific articles, laws and other public
documents.

Referencing web pages

Choose the reference type Web Page. In the Year-field, only enter the year when the page was
latest updated. In the Access Date-field, enter the whole date for when you accessed the page.
Be consistent with the date format. We recommend YYYY.MM.DD. For the example below, the
access date was 2016.01.12.

5,?— EndMote X8 - [World Health Organization, 2016 #75]

@ File Edit References Groups Tools Window Help
4m mp Reference | Pattached POFs | (@
E | -'_"_.'" E‘,‘ O\.‘ Q%‘ = Wi | Plain Font - Plain Size

Reference Type: Web Page >

B

.....

Author

World Health Organization,

Year

2016

Title

Cholera vaccine supply set to double, easing global shoertage
Place Published

[Geneve]

Publisher

World Health Organizap

Access Date

2016.01.12

Keywords

kolera

vaksinering

Notes

Siteres i tredje avsnitt

URL
http:/fwww.who.int/cholera/vaccines/double/en/

11



The reference in APA 6'"- Norwegian:

World Health Organization. (2016). Cholera vaccine supply set to double, easing global shortage
Hentet fra http://www.who.int/cholera/vaccines/double/en/

Referencing official documents in EndNote

There are no set rules for citing official publications. Different study fields have their own ways
of doing things and the bibliographical styles (like APA and Chicago) may have their own rules.
Here you will find some examples on how to solve this problem.

NOU and reports to Stortinget

You can choose between the document type Book or Government Document.

A main rule in EndNote is to put a comma at the end of what you write in the Author-field when
you are referencing official documents. This makes EndNote understand that what you have
written is not a personal name.

In this example, the report to Stortinget has the reference type Book:

Rereren:e|‘@4|a-hed s | @ b
EH_'_J‘E‘,‘ @‘@@‘mammt - Painsize ~| B [ Q@‘ At AL Aa-

Reference Type: Book Ly -

Author

NOU 2008: 14,

Year

2008

Title

Samstemt for utvikling? : Hvordan en helhetlig norsk politikk kan bidra til utvikling i fattige land
Series Editor

Utenriksdepartementet

Place Published

Oslo

Publisher

Utenriksdepartementet

URL
http://www.regjeringen.no/nb/dep/ud/dok/nou-er/2008/nou-2008-14.htm|?id=525832
Access Date

2013.05.07

12
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In this example, the NOU has the reference type Government Document. With this reference
type, you have the possibility of entering a URL:

@ EndMote X8 - [NOU 2008: 14, 2008 £7] /
@ File Edit References Groups Tool/Window Help

Reference 'E Attached PDFs

EH-__"‘ E‘,‘o\.| @.E’E‘ Plain Font ~ Painsize = | B T u@‘ AL A Aa-

Reference Type: Government Document =

I,

qqqqq

Author

NOU 2008: 14,

Year

2008

Title

Samstemt for utvikling? : Hvordan en helhetlig norsk politikk kan bidra til utvikling i fattige land
Department

Utenriksdeparternentet

Place Published

Oslo

Publisher

Utenriksdeparternentet

URL
http:/fwww.regjeringen.no/nb/dep/ud/dok/nou-er/2008,/ nou-2008-14 . html?id=525832
Access Date

2013.05.07

Laws

You can choose between the document types Legal rule or regulation or Book. Write the law’s
short title is written in the Author field. If you want to cite a specific paragraph of the law, use
Edit & Manage Citation(s) in Word to enter the paragraph.

13



@ EndMote X8 - [Arbeidsmiljgloven, 1986 #263} ~
@ File Edit References Groups Tools Window Help

Reference @ittachec\ PDFs @
E El%| &3 6

Reference Type: Legal Rule or Regulation

Plzin Font - Painsize + | B I U E“ AL A L Al

Author
Arbeidsmiljeloven,
Year

1986

Title

Lov av 4.februar 1977 om arbeidervern og arbeidsmilje m.v. med endringer g tillegg, sist ved lov av 13, desember 1985
Place Published
Qslo

Publisher
Grendahl
Keywords
arbeidsforhold
lover

Exporting references from databases and library catalogues
to EndNote

Remember that references that you export from databases may contain flaws, deficiencies or
unnecessary information.

ALWAYS remember to edit your references after importing them:

o Choose the correct reference type
e Check that all the information is correct and in the right field
e Remove or add keywords.

References are places temporarily in the folder “Imported references” in EndNote. This makes it
easy to remember to edit the references.

14



ORIA

e Search the database

e Click on the menu «Show actions options» [three dots] on the right side in the
bibliographical post you want to export into EndNote.

] * E -
BOK w B
: Frafz

Framing environmental disaster : environmental advocacy and

the Deepwater Horizon oil spill E
Melissa K. Merry Fysis
2014
Routledge Research in Environmental Policy and Politics m
Tilgjengelig online Artikl
Avisa
J Click on EndNote Desktop. NB! Do not choose EndNote here, you will then enter

EndNote online.

BOK LI I ¢
Framing environmental disaster : environmental advocacy and
the Deepwater Horizon oil spill
Melissa K. Merry
| 2014
Routledge Research in Environmental Policy and Politics

Tilgjengelig online

= L1] & g B s} 3
E-POST SITER SKRIVUT PERMALENKE RIS BIETEX ENDNOTE ENDNOTE DESK1
. Klikk Download

= ” = & B B k] “

E-POST SITER SKRIV UT PERMALENKE RIS BIETEX ENDHOTE ENDNOTE DESK1

Tegnsett (velg UTF-8) w

LAST NED

J The reference will now be exported into EndNote.

If you click EndNote Desktop and don’t see Download you may have to scroll down the page
to see it.

15



EBSCO — Academic Search Premier, Cinahl, Eric, Soclndex et cetera.

e Search the database

e Select the references by clicking

o Alist of the selected references will appear on the right. Click on “Folder View”

o Select the references you want to export

e Click Export (on the right)

e Select Direct Export in RIS Format
e Click Save

e Edit the reference in EndNote

Web of Science

e Search the database
e Select the references you want to export

uuuuuuuuuuuuuu

Research Domains -
[] SOCIAL SCIENCES

|| SCENCE TECHNOLOGY

[ ARTS HUMAHITIES = 772.2% Published: OCT 2013

Refine

Wil Craate Chation Report

Times Clied: 0
froam AT Difabwres

Times Ched: 1
(frum AL Datateses

Times Clisd: 0
(from AT Databases

e Click Save to EndNote desktop (not Save to EndNote online)

e Click Send
e Edit the reference in EndNote

16



OnePetro

Search the database
Select the references you want to export
Select Export marked citations at the top of the page

Sort by: | Relevance [+] ltems per page: |10 [=]

(] warkai - Export marked citations

Choose Reference manager (RIS)
o Edit the reference in EndNote

N.B. Unfortunately OnePetro does not function optimally with EndNote, so you will need to edit
the references. A number of important fields will be missing, like year, journal title, volume, issue
and article page number. It is important that you add this information to ensure that your
reference is correct!

Google Scholar

Before starting your search, go to settings on the start page.

&= Mitt bibliotek # Mine sitater =4 Varsler M Metrics ¢ Innstillinger

Google

scholar

Go to Bibliography manager, check the box called “Show links to import citations into” and then
choose EndNote from the dropdown menu.

17



Direct import of PDF-files

You can import PDF files that have a DOI (most scientific articles have DOI) to EndNote.
EndNote will then automatically fill in the required fields for you. Remember to check that the

import was successful and that all required fields are filled in correctly!
Importing PDFs can be done in two ways:

1) "Drag and drop"

Select the PDF-files you want to import, drag them into your library and drop them in the toolbar.

(Don't drop them into the library).

e File Edit References Groups Tools Window Help

o® | APA_6th_UIA_Norsk_Bekm_Kil - El SRt | B bE | (O 2 - @ | Quick Search
My Library | ® @ Author Year Title Rating Journal
All References 5 @ Honeybun-A.. 2019 The promise and practice of spontan.. Cultural Ge..
& Imported Referenc.. (1) Honeybun-A.. 2019 The promise and practice of spontan... Cultural Ge...
@ Configure Sync.. L] Jakobsen, J.... 2017 Developing a Pilot Case and Mod... Energy Pr...
D Recently Added % Jensen, T. B... 2000 EOR Screening for Ekofisk SPE Europ
. L] Koch, Leah .. 2017 3D Reconstruction of a Normal Fa... 79th EAGE ...
Bijunfiled (39) ] ) ] )
Li, H;Dong,.. 2019 Thermo-physical properties of CO2 ... Applied Ene...
W Trash (9
® Z Lindner,T... 2011 Good outcome in every fourth re... Resuscitati...

2) Import files or folders

a. From File, select Import

b. Select File to import files, Folder to import a folder
c. Click on Choose to select the file / folder

d. Select PDF from Import Option

e. Click Import
Import File ? 5
Impart File: |A-palaendietary-invesﬁgaﬁon-of—a-mu |Choose. . |
Import Option: | PDF 4 |
Duplicates: Import Al o
Text Translation: Mo Translation ~
Import Cancel

18



Administering your library’s references

Groups

You can use groups to sort references by subject or study field. Groups make it easier to keep

track of your library’s references. A reference may be linked to several groups. Even though a

reference is linked to a group, you will still find it in All References.

How to make a group

e Go to Groups — Create Group

e Type in your new group’s name

¢ Go to All References

¢ Click and drag the desired references into your new group

To delete a group, go to Groups — Delete Group. If you want to make a new group from a
combination of several groups, go to Groups — Create from Groups. It is not yet possible to
create subgroups in a hierarchy.

Searching your EndNote library

The easiest way of searching your library is to type your search into the search bar:

| () S -

®| Quick Search L = 3 Show Search Panel

If your library has many references, you may want advanced search options. Go to Tools —

Search Library. Among other things, you can search references by the date they were added to

the library.
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- EL @ = @ @ Iil =] ‘ Iil |:E' [E ‘ O &i— Ly - ® ‘ Quick Search Q. » # Hide Search Panel
Search Search Whole Library - DMatch Case DMan:h Words Reference Preview @;ttached PDFs
- Lov av 4.februar 1977 om arbeidervern ot
EVEET - contains h | E] endringer og tillegg, sist ved lov
And ~  Any Field ~ Contains - | B (1986).
And *  Any Field v Contains - | =)

You can also search within your library’s PDFs.
Finding full text (PDF) for a reference

Select the references you want to find full text to (select more than one by pressing and holding
the shift button).

Click the Find Full Text-icon in the toolbar: ' @ |
EndNote will now search available publications for full text documents.

A search group will appear in the left column to indicate that the search has started. A paperclip
icon will appear next to the references that have PDFs. To read the PDF: click once on the
reference.

W, | | vJ Q. Search Library

e~ OB rmlAa ¥y e

Mavigation Toolbar

1( t&

Annotate toolbar

|,e S———— 4 et 021

IE Reliahibzy Engineesing and System Safety .
L8 =3

- i i i b

If your screen layout is set to Right — PDF, click the arrow on the right to view additional PDF
tools.

A
Click the icon Open PDF to read the article in full screen mode.

=,
Click Annotate toolbar to add notes and/or highlight text in the PDF file. ‘ 7

Click Attach File to manually add PDF files to a reference. g

Please note that EndNote will be unable to find full text for all references.
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Editing references

e Double-click a reference
e Make your changes and save by closing the window or Ctrl + S

Copying references

This function is useful for referencing multiple articles from the same book or journal.
o Select a reference by clicking it once
e Ctrl + C to copy the reference
e Ctrl + V to paste the copied reference
¢ Double-click the copied reference to edit

Deleting references

Select the reference you want to delete, and click Delete. Deleted references are moved to the
Trash folder in the left column. To empty the trash right-click and select Empty Trash.

NB! Do not delete references after citing them in a Word document.

Remove duplicates

To avoid having duplicates in your library, take care that Discard Duplicates is always selected
when you import references.

Import Options: | Reference Manager (RIS) ol

Duplicates: | Discard Duplicates =

Text Translation: | No Translation =

[ cancel | [ Import |

If you suspect you have duplicates in your library, you can search for them by going to
References — Find Duplicates.

21



@ Find Duplicates / [
Comparing 1 and 2 of 2 dupli . Skip Cancel
Select the record to keepgfhe record not selected will be moved to the Trash. Select Skip to go to the next set of duplicates,

feeniiiis Record [ Keep Ths Record |

Ariés, 1976 #87 Ariés, 1975 #269
Ref Type: Book Ref Type: Book

Rating o Rating o
Author Author

Arigs, Philippe Arigs, Philippe

Year Year

1576 1576

Title Title

‘Western attitudes toward death: from the Middle Ages to the
present

Series Editor
Series Title

Place Published

Loandan

Added to Library: 09.02.2016  Last Updated: 09.02.2016

Western attitudes toward death: from the Middle Ages to the
present

Series Editor

Series Title

Place Published

Landan

Added to Library: 22.11.20156  Last Updated: 22.11.2016

Click Keep This Record on the reference you want to keep. The earliest added reference is
always on the left. It is best to keep this one, in case you have cited it in a document.

Sorting

By default, your EndNote library is sorted by author name, but you can choose to sort it by any
other field (title, year and so forth). The easiest way to sort your references is to click on the field

name at the top of the reference window. If you click on Year, all references will be sorted by
year.

Word and EndNote: Cite while you write

EndNote works together with Word so that you can add references from your library as citations
in your text. A literature list will automatically be created and continually updated.

EndNote has thousands of citation and literature list styles to choose from.

After installing EndNote on your PC, you should see an EndNote X8 tab when you open Word.
This is the tab for controlling EndNote in conjunction with Word.
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EndNote tab:

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Vis

r| Go to EndMote Tools ~

e @ Style: Annotated = @. Categorize References +

Q E‘}- Edit & Manage Citationis) = Preferences
Insert = Bibliography v Instant Formatting is Off ~

Citation Loy Edit Library Reference(s) D ] S 9 Help

Inserting a reference as citation

e Open Word
e Place the marker in the text where you want the citation

B

Ipsc_rt

e Click the Insert Citation icon it
e Search for the author you want to cite
e Click Insert
¢ |f you want to see all of your references, type “a” and hit Search

Deleting citations in Word

e Mark the citation you want to delete.
B Goto Endhote
B [dn & Manage Crabion(s)
. . e s .LFI:...-'_,R‘J'.-_'.-
e Click on Edit and Manage Citations = = leem
] I [ | NPT §
Edit Library Reference
Find Reference Updates...
Removwe Citation
e Click on Edit Reference = Remove Citation Insert Citation
e Click OK.

EndMote X8
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Removing the author’'s name/year

When the author’s name is mentioned in the text, you are often required to not include the
author’s name in the citation. Sometimes you may be required to remove the year.

e Choose either Insert & Exclude Author or Insert & Exclude Year. Do not remove them
both, because this will make it hard to find the citation.

oo O_ - EndNoEX?_F;nd & Insert My References

Find Citation: | Q~ aven

TAuthor 4| Year Title

Aven 2011 On the new ISO guide on risk manag...
Aven 2011 ALARP-What does it really mean?

Toce 2011 Technical Service Outreach Strategies...

Reference Type: Journal Article

Record Number: 4

Author: Aven, T

Year: 2011

Title: On the new ISO guide on risk management terminclogy
Journal: Reliability Engineering & System Safety

Volume: 96

Issue: 7

Pages: 719-726

Date: Jul

',- | Cancel Im

Insert
Library: My EndNote Library.enl

Insert & Display as: Author (Year) (
Insert & Exclude Author
Insert & Exclude Year

Insert in Bibliography Only

Adding page numbers to a citation

e Go to Edit & Manage Citation(s)
o Select the citation in question
¢ Type in the page number in the field Pages: 45 or 49-59.

Take care to always include page numbers when using direct quotes (word for word) and
indirect quotes (rewording/paraphrasing). This is important to enable the reader to quickly locate
and assess the source and your use of it. Openness and accountability when using sources are
cornerstones of academic work, and the use of accurate references is a means to this end.
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How to change the output style of references in a Word document

Go to Select another style:

S5tyl  Select Another Style... e

— ~ Annotated
E A

¥  APA Bth

Author-Date
Chicago 16th Footnote

cancel MHRA (Author-Date)
Numbered
Show All Fields
Turabian 8th Footnote
Vancouver

r

You can also change the output style via EndNote:

Click on this button to go directly to EndNote:

e Go to Edit — Output Style

@ Go to EndMote

@ File Edit References Groups Tools Win

dow Help

E]@ ‘ Select Another Style... - @ @ & @ @‘ T;:‘ E @ IEEI‘ O S 2 - ®| Quick Search Q
My Library B ||® @ auvthor ~ Year  Title Rating Journal
1990  The Green booklet: some measures used in dif...
@ Sync Stetusn Agledahl, KM; G... 2011  Courteous but not curious: how doctors’ polite... Journal of med...
D Recently Added o @ Album, Dag; Wes... 2008 Mﬂce .
® @ Alikhanov,A.A. 2013 Choose A Style s — EqQ.. |
B unfited (47) | @ @ Awarez-Sanlaim... 2013 tion .. '
T Trash ) Alvesson, Mats; 5. 2012 MName Category o elat..
[ Andersen, B. 2010 Annals Internal Medicine Internal Medicine mal.. |
= My Groups _
[ Anderson, Harle.. 1997 Annals of Oncology Oncology [
B Forstenjelp @ Anderson, Harlene 2003 Annotated Generic
B} Open Access @ @ Angus, ScottV.. 215 APA Sth Peychology Bi..
Bl skjennlitteratur @ Arbeidsmilieloven, 1986 APA 8ih - Sentence Case Psychology
. APA sth (sections) Peychology
2 Teologi ©) Aries, Philippe 1976 28 & Comy i
. : :’""d‘d":":"'— ;:i; ! | apasthcy Psychology e
weyard, Helen ! | APA sth-Annotated Psychology
[ Axelsson, Christ.. 1992 |il | apA 6th-full name Psychology | fourn...
®  Baley Cara;Mur.. 2011 || \[Giini...
Bang, Susanne 2002 || | App Animal Behaviour Sd Zoology il
] Bateson, Gregory 1972 || —imsrhusteses e
Beauchamp, Mar.. 2002 || Cuick Search v mic...
®  BeckerEmest 1973 ||
®  JessicaBenjamin 2004 || glessInfos | styeinfoprevien | [ cancel | [ choose | ||pamal..
®  Benktson, Benkt.. 1976 ||
Benner, Patricia 1984 File Name: APA_6th_norsk.ens
[ ] Benner, Patricia 1994 | Created: 17, desember 2015, 14:47:43
[} Benner, Patricia 2011 i Modified: 9. februar 2016, 09:15:53 IMed...
®  Benner PiSutp.. 2007 ‘Zt’;: N Nurs...
[ ] Bion, Wilfred R. 1962 ‘
®  Bion WilfredR; . 1994 Commens: [Denne stlen er en norsk tilpasning til APA bth som kan =
Birolini, Alessandro 2010
Bise, Christopher ). 2003 Showing 503 of 503 output styles.
®  Black 2007 N P ——— — [
®  Bollas, Christoph... 1989  Forces of destiny: Psychoanalysis and human idi...

o The styles are arranged in alphabetical order. Go to Open style manager to find styles

for different disciplines
o Select the style of your preference
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e Select the red cross to save

¢ Click this icon to go back to Word: ' | ] @'@ O .

e Locate the new style from the dropdown menu:

HIJEM SETTINN UTFORMING SIDECPPSETT REFERAMNSER MASSEUTSENDELSER SE GIENNOM VISNING

[L) @ Goto EndNote Style: |APAGth - & Categorize References = Export to EndMote ~
F‘}‘ Edit & Manage Citation(s) |.E,' Up Select Another Style.., Instant Formatting is Off = :—E Preferences
Insert ADAE
“itation = [} Edit Library Referencels) B3, Co APABLH @ Help
- APA_6th_norsk
Citations | IF] Tools

BMI

o Select the style

How to cite several authors simultaneously

When referring to two (or more) documents simultaneously, the citations need to be in the same
parenthesis.

o GotoWord
e Select the place in the text where you want the reference to be

E

Insert
e Go to Insert Citation Citation~

e Type “a” in the search field
e Select the first reference

26



:' ﬁ ﬁ; 120% =] (@

1L2.0.6, EndNote X7 Find & Insert My References N

Find Citation: (Q~ a

Author ~ Year Title

2010 Risikostyring: prinsipper og retningsl.. %
2010 Celebrating 15 years of delicious dis... ]
2007 Tastefully inspired: marketplace reci... I
Al-Saji 2010 The Racialization of Muslim Veils: A...
Andersen 2010 The intensive care unit: a room of m...
Andersen 2007 Oppfatninger om kunnskap og barrie...
Arbeidsmiljelo... 2014 Lov om arbeidsmilje, arbeidstid og st..
Aven 2011 On the new ISO guide on risk manag.
Aven 2011 ALARP-What does it really mean?
Berntsen 2014 ILO og H&M inngar viktig avtale
LY annn P Y ST SN TR A N

Reference Type: Journal Article

Record Number: 3

Author: Aven, T

Jones-Lee, M

Year: 2011

Title: ALARP-What does it really mean?
Journal: Reliability Engineering & System Safety
Volume: 96

Issue: 8

Pages: 877-882

@) | Cancel || Insert |+ |

e Click on Insert
e Select the next reference and click on Insert
o Both of the references should now be in one parenthesis

Moving text

It is a good idea to turn off formatting if you are going to make significant changes in your
document, such as moving paragraphs or pasting in text from other documents.

What to do before moving text:

e Open the Word document
e Go to tools on the EndNote toolbar, and select Convert to Unformatted Citations.

HIJEM SETTINN UTFORMING SIDEQPPSETT REFERAMSER MASSEUTSENDELSER SE GJENNOM VISNING

[} ] @ Goto EndNote Style: |APABth - Et- Categorize References - Export to EndMote -
Ineert lZT’,"Edit&:Manage Citation(s) LE,' Update Citations and Bibliography In:tant Formatting is Off ~ _,=_Preference5
“itation - E‘.ﬁ. Edit Library Reference(s) E: Convert Citations and Eibliography = 0 Help
Citations [? Convertto Unformatted Citations ra Tools

E} Convertto Plain Text
Fyq Convert Reference Manager Citations to EndNote
EH Convert Word Citations to EndMote

You do not need to turn off formatting for the entire document, it is sufficient to only turn it off for
the paragraph you want to move. To do this, highlight the desired paragraph before converting
to unformatted citations. This will make the citations look like this: (Amas, 2008 #878).
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e Move the text or make the changes you want

o Go to Bibliography — Update Citations and Bibliography to make the citations look
correct

e Finally, turn on the formatting again (see below)

It is a good idea to turn off formatting regularly, also when you are not moving text. This is
especially important when working with large documents. This will ensure that the connection
between EndNote and Word functions properly.

Turn on formatting

If your citations look strange or cryptic (Amas, 2008 #878), the formatting is switched off.
To turn it on:

e Go to Bibliography on the EndNote toolbar
e Click on Turn Instant Formatting On

M @Categnrize References = Expu:urttu:u EndMote -
Instant Formatting is Off = EF‘referencE:
- Turn Instant Formatting On

thy Configure Instant Formatting... Tools

Removing the connection between EndNote and Word before turning in
your paper

Use this function to make a copy of your document which does not contain CWYW field codes.
The connection between EndNote and Word is removed in this copy. When the field codes are
removed you can make the final adjustments in the literature list and the citations.

o Make a copy of the document you want to convert to plain text.
e Go to Tools on the EndNote toolbar
e Click on Convert to Plain Text

NB! A notification will appear, letting you know that a copy is created, but not yet saved. Click
OK and save the copy with a file name indicating that this is a document with no connection to

28



EndNote. The copy is a regular Word file. The original document, which is connected to

EndNote, remains intact.

Compressed Library

Compressed Library is used to make a backup of your library in one file, or send your library
via e-mail.

Choose File > Compressed Library (.enlx). You will see this:

sesson, Mats; 5.
wersen, B.

L2012
2010

wderson, Harle... 1997

wderson, Harle..
gus, Scott V.; .
iés, Philippe
unda, Paul A.; ..
reyard, Helen
ielsson, Christ...
iiley, Cara; Mur.
ng, Susanne
teson, Gregory|
auchamp, Mar.
wcker, Ernest
ssica Benjamin
nktson, Benkt.
mnner, patricia
wnner, Patricia

L LN L L L AL L3 S R
Un-and re-thinking leadership: Contex, relations...
The intensive care unit: a room of meaning for...

Conversation, language, and possibilities: a pos...

v e ermnapr e -
Advancing relat...
Nordic Journal ...

Compressed Library (enld

= =)

nner, Patricia

wnner, P.; Sutp...

on, Wilfred R.

on, Wilfred R.; ...
-an, Adrian; Pul...

If you are working together and want to share a library, we recommend using EndNote

Online.

(@) Create (@) With File Attachments

() Create & E-mail () Without File Attachments

@) All References in Library: 10D EndMote Library.enl
() Selected Reference(s)

() All References in Group/Group Set: | My Groups

MNext ] [ Cancel

—jal of Med...

1962
1994
2013

Learning across the professions: ﬁe clergy, ac...
Learning from experience

Clinical seminars : and other works

Ship Hydrostatics and Stability

Team access to one reference library
Think Globally, Work Locally—Library Sharing.

How it works:

Journal of Nurs...

isors & B...

ology & ...

£an jourm.
al of Clini...

Dynamic...

‘Bychoanal...

17.06.;
09.02.
09.02.
09.02.
01.03.
09.02.
12.01.
09.02.
12.0L
09.02.
09.02.
09.02.
07.05.;
09.02.
09.02,
09.02.
09.02.
09.02.
09.02.
09.02.
09.02,
09.02.
18.02.;

- You can share with anyone using EndNote X9 (up to 100 people).

- Share your entire EndNote library, including references, PDFs, and annotations.
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Everyone can add to, annotate and use the library — at the same time.
Review the activity of the changes your collaborators are making via the Activity Feed

Dy .
function
There’s no charge for sharing, no library size limit and no charge for unlimited cloud
storage.

How to share your library or create a new team library

Whether you want to share your existing EndNote library or work as a team to create a new
library from scratch, it's easy to get started.

Since sharing relies on our sync services, you must first set up your EndNote account and fully
sync your library before you can share.

If you've already done this, then just go to File > Share and enter the email addresses of the

people you want to collaborate with.

If you haven't, start by clicking the Sync icon D on the toolbar. You will be prompted to enter
your account credentials or create a new account, if you haven’t done so already.

Once your account is created and your library is fully synced, you can begin sharing.

Sync times can vary depending on the size of your library. Be sure to check the Sync Status,
located in the My Library panel, to make sure your library is fully synced before sharing.

\
EndNote Login e

Create a new EndNote Account

If you don't have an EndNote account or aren't Sign Up

sure, then dick Sign Up.

EndMote Account Credentials

E-mail Address:

Password:

Forgot Password

QK ] | Caneel
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How to join a library someone has shared with you

Once you've accepted the invitation, follow these 3 easy steps:

1. Create an EndNote account and connect it to your desktop version of EndNote.

2. In the Preferences menu, select Sync. Follow the instructions to log in or set up a new
account.

3. Once connected, select File > Open Shared Library.
Start sharing! You can now add to, annotate and use the library, even if others are using it at the
same time.

More details on how to share an EndNote research library

Who can | share my library with? Anyone who has EndNote, no matter where they are
located. EndNote library sharing is not restricted to people within the same firewall or
organization.

How many libraries can | share? You can share one library from your Mac or Windows
desktop. The library that you share will also be the library that you can access online at
my.endnote.com or on your iPad using the EndNote for iPad app.

There is no limit to the number of libraries that can be shared with you by others.

Can | access a shared library from anywhere? If you are the one who shared the library, you
have access to this library on your desktop, online, or on your iPad. If you have been invited to
access someone else’s library, you can only access this library from your desktop.

What if | no longer want to share my library? You can easily control access to your library
from your desktop version of EndNote. Add or remove individual access by going to File >
Share.

Word
Anyone who can access the shared EndNote library can cite from this library in the same word
document.

If you are going to merge two or more Word documents with citations from the same library, it is

important that you unformat the Word documents first. See the section above concerning
unformatting the Word document.
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Share Groups in EndNote Online

If you do not want to share attachments, need to share references with people using older
versions of EndNote or EndNote basic, need to control other users’ access rights, or need to
share with more than 100 others, you can share groups through EndNote online.

With this method of sharing references, the owner of the references puts them in a shared
EndNote online group. The owner of the references controls access to them, so one user could
be given read-write access while another could be limited to read-only access. This method
allows a large number of users to be given access to the same set of references for
collaborative work. Atthe same time, if groups are created for specific projects, it can also
allow the owner to limit shared access to only the references for a project instead of the entire
library. EndNote online data is kept on secure servers. These servers are kept in locked rooms,
with strictly limited employee access, and use SSL encryption for data security. Please note the
following restrictions.

This method allows sharing of the EndNote desktop/online record data, but does
not allow sharing of attachments, even within your own organization. However, you can
share links to documents stored online. So, if you have a copy of a document in a
SharePoint or DropBox folder, you can share a link to the external copy of the document
using the URL field.

Groups can only be shared with other EndNote online or basic users, and you will need to
know the email addresses used as account names by such users to share references with
them.

Tutorial on EndNote online.

Sharing groups in EndNote online.

Problems with EndNote?

If you are experiencing problems when using EndNote, do not hesitate to contact us!

E-mail: ub@uis.no

Phone: 51 83 11 00

Last updated: 18th of March 2020.
32


https://clarivate.libguides.com/endnote_training/endnote_online
https://www.uis.no/getfile.php/13560212/Biblioteket/PDF/Endnote_Online.pdf
mailto:ub@uis.no

	EndNote
	Locating and starting EndNote
	Your library
	Modes
	Style
	Display fields
	Rating
	Here you can rate your references by giving them 1 to 5 stars.  Preview
	Layout
	References
	Change case
	Adding references manually
	Some fields are mandatory for a complete reference
	Kildekompasset.no
	Making references of electronic sources
	Referencing web pages
	Referencing official documents in EndNote
	NOU and reports to Stortinget
	Laws

	Exporting references from databases and library catalogues  to EndNote
	ORIA
	EBSCO – Academic Search Premier, Cinahl, Eric, SocIndex et cetera.
	Web of Science
	OnePetro
	Google Scholar

	Direct import of PDF-files
	Administering your library’s references
	Groups
	How to make a group

	Searching your EndNote library
	Finding full text (PDF) for a reference
	Editing references
	Copying references
	Deleting references
	Remove duplicates
	Sorting

	Word and EndNote: Cite while you write
	Inserting a reference as citation
	Deleting citations in Word
	Removing the author’s name/year
	Adding page numbers to a citation
	How to change the output style of references in a Word document
	How to cite several authors simultaneously
	Moving text
	Turn on formatting
	Removing the connection between EndNote and Word before turning in your paper

	Compressed Library
	Team access to one reference library
	How it works:
	How to share your library or create a new team library
	How to join a library someone has shared with you
	More details on how to share an EndNote research library

	Share Groups in EndNote Online
	Problems with EndNote?


